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SUMMARY: 28 
This protocol describes the dynamics of viral infections using luciferase- and fluorescence-29 
expressing recombinant (r)SARS-CoV-2 and an in vivo imaging systems (IVIS) in K18 hACE2 30 
transgenic mice to overcome the need of secondary approaches required to study SARS-CoV-2 31 
infections in vivo. 32 
 33 
ABSTRACT: 34 
The coronavirus disease 2019 (COVID-19) pandemic has been caused by severe acute respiratory 35 
syndrome coronavirus 2 (SARS-CoV-2). To date, SARS-CoV-2 has been responsible for over 186 36 
million infections and more than 4 million deaths worldwide. Similar to other viruses, studying 37 
SARS-CoV-2 requires the use of experimental methods to detect the presence of virus in infected 38 
cells and/or in animal models. To overcome this limitation, we generated replication-competent 39 
recombinant (r)SARS-CoV-2 that expresses bioluminescent (nanoluciferase, Nluc) or fluorescent 40 
(Venus) proteins. These reporter-expressing rSARS-CoV-2 allow tracking viral infections in vitro 41 
and in vivo based on the expression of Nluc and Venus reporter genes. Here the study describes 42 
the use of rSARS-CoV-2/Nluc and rSARS-CoV-2/Venus to detect and track SARS-CoV-2 infection 43 
in the previously described K18 human angiotensin-converting enzyme 2 (hACE2) transgenic 44 
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mouse model of infection using in vivo imaging systems (IVIS). This rSARS-CoV-2/Nluc and rSARS-45 
CoV-2/Venus show rSARS-CoV-2/WT-like pathogenicity and viral replication in vivo. Importantly, 46 
Nluc and Venus expression allow us to directly track viral infections in vivo and ex vivo, in infected 47 
mice. These rSARS-CoV-2/Nluc and rSARS-CoV-2/Venus represent an excellent option to study 48 
the biology of SARS-CoV-2 in vivo, to understand viral infection and associated COVID-19 disease, 49 
and to identify effective prophylactic and/or therapeutic treatments to combat SARS-CoV-2 50 
infection. 51 
 52 
INTRODUCTION: 53 
Severe acute respiratory syndrome coronavirus 2 (SARS-CoV-2) is an enveloped, positive-sense, 54 
single-stranded RNA virus that belongs to the Betacoronavirus lineage in the Coronaviridae 55 
family1. This viral family is divided into Alpha-, Beta-, Gamma-, and Delta-coronavirus1. Alpha- 56 
and Betacoronaviruses mainly infect mammals, whereas Gamma- and Deltacoronavirus infect 57 
almost exclusively birds2. To date, seven coronaviruses (CoV) have crossed species barriers and 58 
emerged as human coronaviruses (HCoV): two alpha-CoVs (HCoV-229E and HCoV-NL63) and five 59 
beta-CoVs (HCoV-OC43, HCoV-HKU1, SARS-CoV, Middle East respiratory syndrome coronavirus 60 
[MERS-CoV], and SARS-CoV-2)3–6. SARS-CoV, MERS-CoV, and SARS-CoV-2 are highly pathogenic, 61 
causing severe lower respiratory tract infection7. Prior to the emergence of SARS-CoV-2, there 62 
were two epidemic outbreaks caused by CoVs: SARS-CoV in Guangdong Providence, China, from 63 
2002–2003, with a case fatality rate (CFR) of about 9.7%; and MERS-CoV in the Middle East from 64 
2012 to present, with a CFR of about 34%7,8. SARS-CoV-2 has an overall CFR between 3.4%–49%, 65 
with underlying conditions contributing to a higher CFR8,9. Since its discovery in December 2019, 66 
in Wuhan, China, SARS-CoV-2 has been responsible for over 186 million human infections and 67 
more than 4 million human deaths worldwide7,10–12. Notably, since late 2020, new SARS-CoV-2 68 
variants of concern (VoC) and variants of interest (VoI) have impacted virus characteristics, 69 
including transmission and antigenicity9,13, and the overall direction of the COVID-19 pandemic. 70 
For the treatment of SARS-CoV-2 infections, there is currently only one United States (U.S.) Food 71 
and Drug Administration (FDA) therapeutic antiviral (remdesivir) and one Emergency Use 72 
Authorization (EUA) drug (baricitinib, to be administered in combination with remdesivir)14. 73 
There are also 5 approved EUA monoclonal antibodies: REGEN-COV (casirivimab and imdevimab, 74 
administered together), sotrovimab, and bamlanivimab and etesevimab administered 75 
together15–19. There is currently only one FDA-approved prophylactic vaccine, Pfizer-BioNTech, 76 
and two other prophylactic vaccines (Moderna and Janssen) have been EUA approved20–24. 77 
However, with the uncontrolled infection rate and the emergence of VoC and VoI, SARS-CoV-2 78 
still poses a threat to human health. Therefore, new approaches are urgently needed to identify 79 
efficient prophylactics and therapeutics to control SARS-CoV-2 infection and the still ongoing 80 
COVID-19 pandemic. 81 
 82 
Studying SARS-CoV-2 requires laborious techniques and secondary approaches to identify the 83 
presence of the virus in infected cells and/or validated animal models of infection. The use of 84 
reverse genetics has allowed for the generation of recombinant viruses to answer important 85 
questions in the biology of viral infections. For instance, reverse genetics techniques have 86 
provided means to uncover and understand the mechanisms of viral infection, pathogenesis, and 87 
disease. Likewise, reverse genetics approaches have paved the way to engineer recombinant 88 



viruses lacking viral proteins to understand their contribution in viral pathogenesis. In addition, 89 
reverse genetics techniques have been used to generate recombinant viruses expressing reporter 90 
genes for in vitro and in vivo applications, including identifying prophylactic and/or therapeutic 91 
approaches for the treatment of viral infections. Fluorescent and bioluminescent proteins are the 92 
most commonly used reporter genes due to their sensitivity, stability, and easy detection based 93 
on the improvement of new technologies25,26. In vitro, fluorescent proteins have been shown to 94 
serve as a better option for the localization of viruses in infected cells, while luciferases are more 95 
convenient for quantification studies27–29. In vivo, luciferases are preferred over fluorescent 96 
proteins for whole animal imaging, while fluorescent proteins are preferred for the identification 97 
of infected cells or ex vivo imaging30–32. The use of reporter-expressing recombinant viruses has 98 
served as a powerful tool for the study of viruses in many families, including, among others, 99 
flaviviruses, enteroviruses, alphaviruses, lentiviruses, arenaviruses, and influenza viruses28,33–36. 100 
 101 
To overcome the need for secondary approaches to study SARS-CoV-2 and characterize real-time 102 
SARS-CoV-2 infection in vivo, we have generated replication-competent recombinant (r)SARS-103 
CoV-2 that expresses bioluminescent (nanoluciferase, Nluc) or fluorescent (Venus) proteins using 104 
our previously described bacterial artificial chromosomes(BAC)-based reverse genetics, which 105 
are maintained as a single copy in E. coli in order to minimize toxicity of virus sequences during 106 
its propagation in bacteria37,38.  Notably, rSARS-CoV-2/Nluc and rSARS-CoV-2/Venus showed 107 
rSARS-CoV-2/WT-like pathogenicity in vivo. The high level of Venus expression from rSARS-CoV-108 
2/Venus allowed detecting viral infection in the lungs of infected K18 hACE2 transgenic mice 109 
using an in vivo imaging system (IVIS)39. The levels of Venus expression correlated well with viral 110 
titers detected in the lungs, demonstrating the feasibility of using Venus expression as a valid 111 
surrogate of SARS-CoV-2 infection. Using rSARS-CoV-2/Nluc, we were able to track the dynamics 112 
of viral infection in real-time and longitudinally assess SARS-CoV-2 infection in vivo using the 113 
same IVIS approach in K18 hACE2 transgenic mice. 114 
 115 
PROTOCOL: 116 
 117 
Protocols involving K18 hACE2 transgenic mice were approved by the Texas Biomedical Research 118 
Institute (TBRI) Institutional Biosafety Committee (IBC) and the Institutional Animal Care and Use 119 
Committee (IACUC). All experiments follow the recommendations in the Guide for the Care and 120 
Use of Laboratory Animals of the National Research Council40. The appropriate Personal 121 
Protection Equipment (PPE) is required when working with mice.  122 
 123 
1. Use of K18 hACE2 transgenic mice 124 
 125 
1.1. Purchase and maintain 4–6-week-old female B6.Cg-Tg(K18-ACE2)2Prlmn/J mice (K18 126 

hACE2 transgenic mice) in a biosafety level (BSL)-2 animal care facility under specific pathogen-127 

free conditions.  128 

 129 

1.1.1. After arrival at the BSL2 facilities, allow the animals to acclimate for 7 days and transfer 130 

them to the BSL-3 animal facility for infections and other experimental procedures.  131 



 132 

1.1.2. Following IACUC protocols, place 4 mice per cage. To ensure that the animal is deceased, 133 

after mice infection with rSARS-CoV-2 and in vivo imaging, euthanize the animals with a lethal 134 

dose of Fatal-Plus (>100 mg/kg). 135 

 136 

2. Biosafety 137 
 138 
NOTE: In this manuscript, rSARS-CoV-2 is generated using the BAC-based reverse genetic systems 139 
for SARS-CoV-2 USA-WA1/2020 strain, as previously described37. All in vivo procedures involving 140 
rSARS-CoV-2/Nluc or rSARS-CoV-2/Venus infections must be performed in a biological safety 141 
cabinet under BSL-3 conditions.  142 
 143 
2.1 Clean the biosafety cabinet with 2% Wexicide and 70% Ethanol disinfectant sequentially 144 
before and after performing all the experimental procedures described in this article.  145 
 146 
2.2 Sterilize all dissection material (scissors, dissecting forceps, etc.) and the homogenizer 147 
before and after each use.  148 
 149 
2.3 Clean the isolation chamber and disinfect using MB10 tablets before and after each use 150 
according to the manufacturer’s instruction. 151 
 152 
2.4 Discard all biological material produced during the procedures following IBC and IACUC 153 
guidelines.  154 
 155 
3. In vivo characterization of rSARS-CoV-2 156 
 157 
3.1  Mouse infections 158 
 159 
3.1.1 Place female 4–6-week-old K18 hACE2 transgenic mice in labeled cages, identify the mice 160 
in each cage using an ear punch code and place 4 mice per cage. Use a group of mice for body 161 
weight and survival and another group of animals for viral titration and imaging. 162 
 163 
3.1.2 Before infection, shave mice chest on the ventral side from the pectoral nipple to the 164 
inguinal nipple area to facilitate the bioluminescence signal.  165 
 166 
3.1.3 Prepare the rSARS-CoV-2 inoculum with 105 plaque-forming units (PFU)/mouse under 167 
sterile conditions in a total volume of 50 µL using sterile 1x phosphate buffer saline (PBS).  168 

 169 

NOTE: Calculate the amount of rSARS-CoV-2 to be used in the viral dilution with the formula: 170 
virus needed = (105 PFU per mouse / 50 µL) x final volume) / stock viral titer. 171 
 172 
3.1.4 Keep the virus inoculum chilled on ice. 173 
 174 



3.1.5 Use the mock-infected (1x PBS) and rSARS-CoV-2/WT-infected mice as internal controls. 175 
Place the mock-infected mice in a separate cage than rSARS-CoV-2-infected mice. 176 
 177 
3.1.6 Anesthetize the mice using 5% isoflurane gaseous sedation in an anesthesia chamber and 178 
maintain with 3% isoflurane.  179 
 180 
3.1.7 Once postural reaction and righting reflex are confirmed, place the mouse in the dorsal 181 
recumbency position.  182 
 183 
3.1.8 Scruff the neck of the mouse between the index finger and thumb and hold the tail against 184 
the palm of the hand with the pinky finger to hold the animal in a dorsal position. 185 
 186 
3.1.9 Place the pipette tip containing 50 µL of the virus inoculum in the nostril and slowly eject 187 
the solution. Ensure that the virus inoculum is inhaled and there is no reflux by observing the 188 
inoculum drop disappearing.  189 
 190 
3.2 Bioluminescence monitoring K18 hACE2 transgenic mice infected with rSARS-CoV-2/Nluc 191 
(Figure 1 and Figure 2) 192 
 193 
NOTE: This experiment follows the schematic representation and uses the viruses displayed in 194 
Figure 1. An isoflurane anesthesia attachment is required for the in vivo imaging system (IVIS). 195 
See Table of Materials for details instruments and systems required. 196 
 197 
3.2.1 Initiate the imaging software and set up the parameters, click image mode to 198 
Bioluminescence, open filter, and set the exposure time to auto. 199 
 200 
3.2.2 Upon initializing the IVIS machine, place the mice in the isolation chamber while still inside 201 
the biosafety cabinet. Induce mice with isoflurane at a 5% concentration. Once loss of the 202 
postural reaction and righting reflex is confirmed, maintain with 3% isoflurane. 203 
 204 
3.2.3 Once mice are anesthetized, remove them from the isolation chamber and retro-orbitally 205 
administer the luciferase substrate diluted 1:10 in 1x PBS (final volume 100 µL/mouse) with a 25 206 
G needle. 207 
 208 
3.2.4 After luciferase substrate administration, place the mice back in the isolation chamber 209 
with their chests facing up and nasal cavity inside the manifold cone to keep the animal 210 
anesthetized during the imaging procedure.  211 
 212 
3.2.5 Transfer the isolation chamber to the IVIS machine, and instantaneously after closing the 213 
IVIS imager door, select Acquire in the software program to initialize  (Figure 2A). 214 
 215 
3.2.6 To analyze bioluminescence images acquired, utilize the ROI (region of interest) tool in 216 
the software to designate the precise signal and measure the flux (Figure 2B). 217 
 218 



3.2.7 Click on Measure and allow the system to begin assessing the bioluminescence in photons 219 
to provide the absolute photon emission comparable to the output measurements provided by 220 
the various parameters. 221 
 222 
3.3 Fluorescence analysis in K18 hACE2 transgenic mice infected with rSARS-CoV-2/Venus 223 
(Figure 3 and Figure 4) 224 
 225 
NOTE: This experiment follows the schematic representation and rSARS-CoV-2 shown in Figure 226 
3. See Table of Materials for details instruments and systems required. 227 
 228 
3.3.1 Initiate the imaging software and set up the parameters, set excitation (500 nm) and 229 
emission filters (530 nm), click image mode to Fluorescence and set the exposure time to auto.  230 
 231 
3.3.2 Euthanize the mice using a lethal dose of Fatal-Plus (>100 mg/kg). Following euthanasia, 232 
disinfect the incision site with 70% ethanol. 233 
 234 
3.3.3  Using tweezers, pull the skin, make an incision from the sternum to the abdomen and cut 235 
the incision from the sides with scissors. Cut the hepatic vein to minimize the amount of blood in 236 
the lungs and avoid high background signals during imaging. 237 
 238 
3.3.4 Using scissors, cut the sternum and open the ribcage. Next, snip the end of the trachea 239 
with scissors and remove the lungs with tweezers. 240 
 241 
3.3.5 Place the excised lungs in a 6-well plate containing 2 mL of 1x PBS and rinse to remove 242 
excess blood. Minimize the possibility of contamination between samples by disinfecting and 243 
cleaning surgery tools between samples using 70% ethanol. 244 
 245 
3.3.6 After initializing the IVIS machine, place the lungs in a black tray and separate the tissues 246 
from each other. 247 

 248 

3.3.7  Place the tray inside the isolation chamber inside the biosafety cabinet, and then transfer 249 
the isolation chamber to the IVIS. Close the door and click on Acquire to initiate the imaging 250 
system (Figure 4A). 251 
 252 
3.3.8 To analyze fluorescence, utilize the ROI tool and draw ROIs around each of the individual 253 
lungs. Measure each ROI manually and then use the average radiant efficiency values given and 254 
subtract from those of the mock-infected mice (Figure 4B). 255 
 256 
3.3.9 Once imaging is complete, place the tissues on ice for same-day analysis or in a cryotube 257 
for dry ice freezing to store at -80 °C for later processing. 258 
 259 
3.4 Lung bright field imaging and pathology scoring of K18 hACE2 transgenic mice infected 260 
with rSARS-CoV-2/Nluc (Figure 2A–C) and rSARS-CoV-2/Venus (Figure 4A–C) 261 
 262 



3.4.1 After imaging bioluminescence of mice infected with rSARS-CoV-2/Nluc, rSARS-CoV-263 
2/WT, and mock-infected, return the mice to their cages. Proceed with euthanasia and the ex 264 
vivo bright field imaging of mice lungs (Figure 2A). 265 
 266 
3.4.2 After imaging ex vivo fluorescence of lungs of infected mice, take bright-field images of 267 
the lungs (Figure 4A). 268 
 269 
3.4.3 Analyze the gross lesions on the surface of the lung using ImageJ (Figures 2C and 4C). 270 
 271 
3.4.4 Open the lung image to be analyzed in ImageJ. 272 
 273 
3.4.5 Calculate the ratio of pixel to cm, use the Straight tool and measure the actual length of 274 
the image.  275 
 276 
3.4.6 After selecting, click on Analyze > Measure to calculate the length of pixels for the length.   277 
 278 
3.4.7 Click on Analysis > Set Scale and input the numbers calculated from the previous step. 279 
 280 
3.4.8 Use the Freehand Selections tool and select the entire lung surface. Click on Analyze > 281 
Measure to measure total lung area.  282 
 283 
3.4.9 Click on Edit > Selection > Make Inverse to select the rest of the lung area, then press 284 
delete or backspace to remove the background.  285 
 286 
3.4.10 Remove the selected area, then click on Image > Adjust > Color Threshold. 287 
 288 
3.4.11 To select pathologic lesion area, adjust Brightness to a minimum (between 1 to 50) and a 289 
maximum (between 50 to 200), depending on the levels of congestion and hemorrhages present.  290 
 291 
3.4.12 Once pathologic lesions are selected, click on Select at the bottom of the threshold color 292 
panel, then click on Analyze > Measure to measure pathologic areas. 293 
 294 
3.4.13 Calculate the percentage of gross lesions with the formula: % of pathologic area = 295 
(measurement of pathologic area/total lung surface) x 100.  296 
 297 
3.5 Viral titrations (Figure 2D and Figure 4D) 298 
 299 
3.5.1 Upon imaging, complete the mice euthanasia and collect lungs, brain, and nasal mucosa. 300 
 301 
3.5.2 Place the lungs, brain, and nasal mucosa into separate sterile tissue homogenizers and 302 
add 1 mL of cold 1x PBS.  303 
 304 
3.5.3 Homogenize the samples by centrifuging at 21,500 x  g for 10 min to pellet cell debris. 305 
Collect and transfer the supernatants into a new sterile tube and discard the pellet. 306 



 307 
3.5.4 If viral titrations are performed the same day, store the supernatants at 4 °C. 308 
Alternatively, freeze the supernatant of the homogenized samples at -80 °C until being evaluated 309 
later. 310 
 311 
3.5.5 Utilizing the supernatants obtained from the tissue homogenates make 10-fold serial 312 
dilutions and infect confluent monolayers of Vero E6 cells with 1 mL of each dilution of the 313 
supernatant (6-well plate format, 1.2 × 106 cells/well, triplicates). 314 
 315 
3.5.6 Let the virus adsorb for 1 h at 37 °C in a humidified 5% CO2 incubator.  316 
 317 
3.5.7 After viral adsorption, wash the cells with 1 mL of 1x PBS and incubate in 2 mL of post-318 
infection media containing 1% Agar in the humidified 5% CO2 incubator at 37 °C for 72 h.  319 
 320 
3.5.8 After the incubation, inactivate the plates in 10% neutral buffered formalin for 24 h at 4 321 
°C, ensure the entire plate is submerged.  322 
 323 
3.5.9 Take plates out of BSL3 and wash the cells three times with 1 mL of 1x PBS and 324 
permeabilize with 1 mL of 0.5% Triton X-100 for 10 min at room temperature (RT).  325 
 326 
3.5.10 Block the cells with 1 mL of 2.5% bovine serum albumin (BSA) in 1x PBS for 1 h at 37 °C, 327 
followed by incubation in 1 mL of 1 µg/mL of the SARS-CoV nucleocapsid (N) protein cross-328 
reactive monoclonal antibody (1C7C7), diluted in 2.5% BSA for 1 h at 37 °C.  329 
 330 
3.5.11 Wash the cells three times with 1 mL of 1x PBS and develop the plaques using the ABC kit 331 
and DAB Peroxidase Substrate kit according to the manufacturers’ instructions.  332 
 333 
3.5.12 Calculate the viral titers as PFU/mL.  334 

 335 

NOTE: Calculate with the formula PFU/mL = dilution factor x number of plaques x (1 mL/inoculum 336 
volume). 337 
 338 
3.6 Nluc activity in tissues of K18 hACE2 transgenic mice infected with rSARS-CoV-2/Nluc 339 
(Figure 2E) 340 
 341 
3.6.1 Quantify the presence of Nluc in the organ homogenates from mock, rSARS-CoV-2/WT, 342 
and rSARS-CoV-2/Nluc infected K18 hACE2 transgenic mice using a luciferase assay following the 343 
manufacturers’ instructions. 344 
 345 
3.7 Evaluation of morbidity and mortality (Figure 2F,G and Figure 4E,F) 346 
 347 
3.7.1 Intranasally infect 4–6-week-old female K18 hACE2 transgenic mice with 105 PFU of 348 
rSARS-CoV-2/WT, rSARS-CoV-2/Venus, rSARS-CoV-2/Nluc, or mock-infected as described in 349 
section 3.1. 350 



 351 
3.7.2 Monitor and weigh the mice over 12 days at the same time to minimize the weight 352 
variation due to food ingestion. Euthanize the mice that lose 25% of their initial body weight since 353 
they have reached a humane endpoint and note these mice as succumbing to viral infection. 354 
 355 
3.7.3 After 12 days, euthanize the mice that survive viral infection and calculate the % of body 356 
weight change and survival. 357 
 358 
REPRESENTATIVE RESULTS: 359 
rSARS-CoV-2/Nluc infection in K18 hACE2 transgenic mice (Figures 1 and 2) 360 
Figure 1A shows a schematic representation of the rSARS-CoV-2/WT (top) and rSARS-CoV-2/Nluc 361 
(bottom) used to assess infections in vivo. Figure 1B shows the schematic flow chart applied to 362 
assess rSARS-CoV-2/Nluc infection dynamics in K18 hACE2 transgenic mice. Four-to-six-week-old 363 
female K18 hACE2 transgenic mice (N = 4) were either mock-infected with 1x PBS or infected with 364 
105 PFU of rSARS-COV-2/WT or rSARS-CoV-2/Nluc intranasally. At 1-, 2-, 4- and 6-days post-365 
infection, mice were sedated using the isolation chamber and then injected with Nluc substrate 366 
retro-orbitally. The isolation chamber was immediately placed in the IVIS and Nluc signal was 367 
assessed in vivo using the imaging software. Nluc expression was readily detected in mice 368 
infected with rSARS-CoV-2/Nluc but not those infected with rSARS-CoV-2/WT, or mock-infected 369 
(Figure 2A). Quantitative analyses showed Nluc intensity at different days post-infection (Figure 370 
2B). Gross lesions on the lung surface of mice infected with rSARS-CoV-2/Nluc were comparable 371 
to those in the rSARS-CoV-2/WT infected group (Figures 2C). Lastly, mice organs (lungs, nasal 372 
turbinate, and brain) were homogenized, and viral titers were determined by plaque assay 373 
(PFU/mL) and Nluc activity was determined using the luciferase assay following the 374 
manufacturer’s instructions. Plaques were assessed by immunostaining using the cross-reactive 375 
SARS-CoV N monoclonal antibody 1C7C7. Viral titers detected in the rSARS-CoV-2/Nluc infected 376 
mice were comparable to those infected with rSARS-CoV-2/WT in all organs at different days 377 
post-infection (Figure 2D). Nluc activity was only detected in the organs from rSARS-CoV-2/Nluc-378 
infected mice (Figure 2E). A separate group of mock-infected and virus-infected mice were 379 
monitored for 12 days for changes in body weight (Figure 2F) and survival (Figure 2G). Mice 380 
infected with rSARS-CoV-2/Nluc and rSARS-CoV-2/WT lost up to 25% of their body weight and all 381 
succumbed to viral infection between 7–8 days post-infection (Figure 2F–G). 382 
 383 
rSARS-CoV-2/Venus infection in K18 hACE2 transgenic mice (Figures 3 and 4) 384 
Figure 3A shows a schematic representation of the rSARS-CoV-2/WT (top) and rSARS-CoV-2/Nluc 385 
(bottom) used to assess infections ex vivo. Figure 3B shows the schematic flow chart applied to 386 
assess rSARS-CoV-2/Venus dynamics in K18 hACE2 transgenic mice. Four-to-six-week-old female 387 
K18 hACE2 transgenic mice (N= 4/group) were either mock-infected with 1x PBS or infected with 388 
105 PFU of rSARS-COV-2/WT or rSARS-CoV-2/Venus intranasally. At 1-, 2-, 4- and 6-days post-389 
infection, mice were euthanized, and their lungs were excised and imaged ex vivo using an IVIS. 390 
Venus expression was readily detected in all lungs from mice infected with rSARS-CoV-2/Venus 391 
but not those infected with rSARS-CoV-2/WT, or mock-infected (Figure 4A). Quantitative 392 
analyses showed that Venus intensity peaks at 2 days post-infection and decreases over the 393 
course of infection in the lungs of infected mice (Figure 4B). Images of the lung surface revealed 394 



gross lesions of mice infected with rSARS-CoV-2/Venus was comparable to that of rSARS-CoV-395 
2/WT infected mice (Figure 4C).  Finally, mice organs (lungs, nasal turbinate, and brain) were 396 
homogenized, and viral titers were determined by plaque assay and assessed by immunostaining 397 
using the SARS-CoV N protein cross-reactive monoclonal antibody 1C7C7. Infection with rSARS-398 
CoV-2/Venus resulted in comparable viral titers to those observed in mice infected with rSARS-399 
CoV-2/WT in all organs (Figure 4D). A separate group of mock-infected and virus-infected mice 400 
were monitored for 12 days for changes in body weight (Figure 4E) and survival (Figure 4F). Mice 401 
infected with rSARS-CoV-2/Venus and rSARS-CoV-2/WT lost up to 25% of their body weight and 402 
all succumbed to viral infection by day 9 post-infection with no survival (Figures 4E-4F). 403 
 404 
FIGURE AND TABLE LEGENDS: 405 
Figure 1: Assessment of rSARS-CoV-2/Nluc infection in vivo using K18 hACE2 transgenic mice. 406 
(A) Schematic representation of rSARS-CoV-2/WT (top) and rSARS-CoV-2/Nluc (bottom). (B) 407 
Schematic flow chart for the assessment of rSARS-CoV-2/Nluc in vivo. 408 
 409 
Figure 2: rSARS-CoV-2Nluc expression in infected K18 hACE2 transgenic mice. (A–B) Four-to-six-410 
week-old female K18 hACE2 transgenic mice were mock-infected (N = 4) or infected with rSARS-411 

CoV-2/WT (N = 4) or rSARS-CoV-2/Nluc (N = 4) using 10
5
 PFU per animal. The mice were 412 

anesthetized at 1-, 2-, 4- and 6-days post-infection, after being retroorbital injected with the Nluc 413 
substrate. (A) Nluc expression was determined under an in vivo imaging system, and lungs from 414 
mock-infected and infected mice were excised and photographed at 1-, 2-, 4- and 6-days post-415 
infection . (B) Nluc intensity was quantitively analyzed by the image analysis software and (C) 416 
gross lesions on the lung surface were quantitively analyzed by ImageJ (C) **P < 0.01. (D) Viral 417 
titers in the nasal turbinate (left), lungs (middle), and brain (right) from mice infected with rSARS-418 
CoV-2/WT and rSARS-CoV-2/Nluc were determined by plaque assay. (E) Nluc activity in the nasal 419 
turbinate (left), lungs (middle) and brain (right) were measured under a luciferase multi-plate 420 
reader. ns, not significant. Mock- and virus-infected mice were monitored for 12 days for changes 421 
in (F) body weight and (G) survival. All data are presented as mean ± SD for each group and 422 
analyzed by SPSS13.0 (IBM). A P value of less than 0.05 (P < 0.05) was considered statistically 423 
significant. This figure has been modified from Ye C. et al.41. 424 
 425 
Figure 3: Assessment of rSARS-CoV-2/Venus infection in vivo using K18 hACE2 transgenic mice. 426 
(A) Schematic representation of rSARS-CoV-2/WT (top) and rSARS-CoV-2/Venus (bottom). (B) 427 
Schematic flow chart for the assessment of rSARS-CoV-2/Venus in vivo.  428 
 429 
Figure 4: rSARS-CoV-2/Venus expression in infected K18 hACE2 transgenic mice. (A–B) Four-to-430 

six-week-old female K18 hACE2 transgenic mice were mock-infected (N = 4) or infected (10
5
 431 

PFU/mouse) with rSARS-CoV-2/WT (N = 4) or rSARS-CoV-2/Venus (N = 4). Lungs were excised at 432 
1-, 2-, 4-, and 6- days post-infection, images of lungs were photographed at 1-, 2-, 4- and 6-days 433 
post-infection.  (A) Venus expression was assessed under an IVIS, (B) fluorescence intensity was 434 
quantitively analyzed by the image analysis software and (C) the gross lesions on the lung surfaces 435 
were quantitively analyzed by ImageJ. **P < 0.01. (D) Viral titers in the nasal turbinate (left), lungs 436 
(middle) and brain (right) from mice infected with rSARS-CoV-2/WT and rSARS-CoV-2/Venus were 437 



determined by plaque assay. ns, not significant. Mock- and SARS-CoV-2-infected mice were 438 
monitored for 12 days for (E) body weight loss and (F) survival. All data are presented as mean ± 439 
SD for each group and analyzed by SPSS13.0 (IBM). A P value of less than 0.05 (P < 0.05) was 440 
considered statistically significant. This figure has been modified from Ye C. et al.41. 441 
 442 
DISCUSSION: 443 
This protocol demonstrates the feasibility of using these rSARS-CoV-2 expressing reporter genes 444 
to monitor viral infections in vivo. Both reporter-expressing recombinant viruses provide an 445 
excellent tool for studying SARS-CoV-2 infections in vivo. The described ex vivo (rSARS-CoV-446 
2/Venus) and in vivo (rSARS-CoV-2/Nluc) imaging systems represent an excellent option to 447 
understand the dynamics of SARS-CoV-2 infection, viral pathogenesis and to identify infected 448 
cells/organs at different times after viral infection. In order to conduct ex vivo (rSARS-CoV-449 
2/Venus) and in vivo (rSARS-CoV-2/Nluc) studies, it is eminent to have accurate and reproducible 450 
infections as well as adequate inoculations of rSARS-CoV-2/Nluc. 451 
 452 
When studying in vivo infections using rSARS-CoV-2/Nluc, mice should be shaved to facilitate 453 
Nluc visualization under the IVIS. There is also a need to inoculate the Nluc substrate for 454 
visualization of Nluc. This may require some experimental testing to determine the 455 
concentrations and volume of the Nluc substrate to ensure a high Nluc signal. When studying ex 456 
vivo infections using rSARS-CoV-2/Venus, and because of limitations of detecting Venus directly 457 
from the entire mice using IVIS, only ex vivo imaging of the lungs allow detection of Venus 458 
expression. This requires having a group of mice to be euthanized at different times points. This 459 
is contrary to the situation of mice infected with rSARS-CoV-2/Nluc since the same group of mice 460 
can be imaged at different days post-infection, without requiring euthanasia at each of the times 461 
post-infection required for rSARS-CoV-2/Venus. An advantage of rSARS-CoV-2/Venus over rSARS-462 
CoV-2/Nluc is that it can be used with flow cytometry to identify what type of cells are infected 463 
by SARS-CoV-2 by simply sorting infecting cells from non-infected cells coupled with the use of 464 
specific cellular markers as we previously described with influenza (REF). One important aspect 465 
of our rSARS-CoV-2/Venus and rSARS-CoV-2/Nluc is that both exhibited WT−like growth 466 
properties in vitro and in vivo without displaying signs of attenuation, allowing us to monitor virus 467 
infection ex vivo in the lungs of infected mice (rSARS-CoV-2/Venus) and the dynamic of viral 468 
replication in the entire mouse (rSARS-CoV-2/Nluc) using noninvasive longitudinal in vivo 469 
imaging.  470 
 471 
Importantly, these reporter-expressing rSARS-CoV-2/Venus and rSARS-CoV-2/Nluc represent an 472 
excellent option for the identification of lead prophylactic and/or therapeutics for the treatment 473 
of SARS-CoV-2 infection41. The use of reporter-expressing rSARS-CoV-2 expressing different 474 
fluorescent proteins used (e.g., Venus and mCherry) allow us to combine them in bifluorescent 475 
assays to identify if therapeutics can efficiently inhibit infection of two viruses at the same time, 476 
in vitro and or in vivo, and to track viral infection, and pathogenesis39. 477 
 478 
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Dear Dr. Amit Krishnan,  

 

Thank you very much for your positive reply to our manuscript JoVE63127R1 “Live 

imaging and quantification of viral infection in K18 hACE2 transgenic mice using 

reporter-expressing recombinant SARS-CoV-2” by Morales Vasquez et al.  

We have carefully considered all the reviewers’ and editorial’s comments and 

suggestions, which have helped us to improve the quality of our manuscript. To address 

the comments made by the reviewers and the editors, as well as to accommodate their 

suggestions, we have introduced several changes in a revised version of the document. 

The following is a point-by-point response to the comments raised by each one of the 

reviewers and the editorial office. 

 

Reviewers comments 

 

Reviewer #1 

Manuscript Summary: The authors developed fluorescent and luminescent 

expressing rSARS-CoV-2 virus for live-imaging use in infected mice, which is an 

important tool and protocol to study the viral infection in vivo and ex vivo. Even though, 

similar study had been published elsewhere (Live Imaging of SARS-CoV-2 Infection in 

Mice Reveals that Neutralizing Antibodies Require Fc Function for Optimal Efficacy, 

Immunity (2021)). A comparable study and detail protocol is still helpful information. 

Response: We appreciate the overall positive and constructive comments made by 

this reviewer regarding the importance and relevance of our protocol. 

 

Major comment: Fig 2 A and C should not be separated as they are the same sample. 

should combines as Fig.2A panel, just bright and fluorescent view, the same for Fig.4. 

Rebuttal letter Click here to access/download;Rebuttal Letter;Letter for JoVE
Reviewers and editorial.docx
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Response: We agree with the comment made by the reviewer. Following his/her 

recommendation, we have combined the panels A and C in Figures 2 and 4, and included 

the changes in our revised version of the manuscript. 

 

Major comment: Fig. 2E and 4E, the data should that virus titer in nasal and lung was 

decreasing as day passed, which is against all the data published on K18 mice, because 

the lung titer should increase and retain at high level during infection, see Immunity 

(2021). The authors should explain why they see decreased viral load in lung, but their 

Nluc activity maintained(Fig.2F). 

Response: We thank the reviewer for this comment and apologize for any potential 

confusion. Previous published manuscripts, including ours (Analysis of SARS-CoV-2 

infection dynamic in vivo using reporter-expressing viruses. Ye C. et al. 2021, A 

bifluorescent-based assay for the identification of neutralizing antibodies against 

SARS-CoV-2 variants of concern in vitro and in vivo. Chiem K. et al. 2021, 

Contribution of SARS-CoV-2 Accessory Proteins to Viral Pathogenicity in K18 

Human ACE2 Transgenic Mice. Silvas J. et al. 2021, Lethality of SARS-CoV-2 

infection in K18 human angiotensin-converting enzyme 2 transgenic mice. Oladunni 

F. et al. 2020) have shown that SARS-CoV-2 replication (e.g. viral titers) peak at 2 days 

post-infection in the nasal turbinate and lungs of infected K18 hACE2 mice; and by 4 days 

post-infection, an approximately 1-2 log decrease in viral titers is observed. This data has 

remained consistent throughout each independent experiment in our laboratory, and also 

work published by others. Regarding the levels of Nluc observed in the lungs of K18 

hACE2 mice infected with the rSARS-CoV-2/Nluc, we have observed that the signal of 

Nluc accumulates throughout the course of infection, even when viral titers decrease 

(Analysis of SARS-CoV-2 infection dynamic in vivo using reporter-expressing 

viruses. Ye C. et al. 2021). This is most likely because Nluc is very stable and accumulate 

in the lungs of infected mice, even when viral titers decrease. 

 

Major comment: survival and weight curve should be shown. aren’t the mice lethal 

to 10^5 pfu of SARS-COV-2？According to literature, K18 mice should be a lethal model. 



Response: We thank the reviewer for this suggestion. Following his/her 

recommendation, we have included the survival and body weight in our revised version 

of the manuscript to show the lethality of the different reporter-expressing rSARS-CoV-2 

in our experiments, which show WT-like lethality in the K18 hACE2 mouse model. 

 

Minor Comment: Check spelling throughout. Line 150. 

Response: We apologize for this editorial mistake. This spelling mistake as well as 

others has been fixed in the revised version of the manuscript.  

 

Reviewer #2 

Manuscript Summary: In the associated manuscript, Vasquez et al generate 

bioluminescent and fluorescent recombinant SARS-CoV-2 reporter viruses and describe 

protocols to visualize and quantify infection in vivo and ex vivo in a K18 hACE2 mouse 

model. This is achieved by the expression of nanoluciferase (Nluc) or Venus proteins via 

a P2A fusion N-terminal to SARS-CoV-2 nucleoprotein (CoV-2 N) generated in a bacterial 

artificial chromosome. The authors describe carefully controlled experiments using the 

reporter viruses, quantifying SARS-CoV-2 infection across a range of samples including 

live mice, nasal turbinate and lung and brain tissue while showing specificity of reporter 

signal to their recombinant reporter virus in comparison to mock infection or infection with 

a WT virus. 

This work provides a useful resource to the community, instructing other researchers 

on how to implement experiments with the described reporter viruses which will further 

understanding of the fundamental biology of SARS-CoV-2, disease mechanisms and 

provide a platform for development of treatments to prevent or ameliorate disease in a 

complex animal model. 

Response: We also appreciate the positive comments on our manuscript made by 

this reviewer indicating that our work “has the potential to have a positive impact on the 

field”, “provides useful resources to the community” to “understand fundamental biology 

of SARS-CoV-2, disease mechanisms” and “a platform for the development of treatments 

against SARS-CoV-2 in the K18 hACE2 mouse model of infection”. 

 



Major comments: No major concerns. 

 

Reviewer #3 

Manuscript Summary: In this manuscript by Vasquez et al from the Luis Martinez-

Sobrido lab, the authors describe the methodology to carry out longitudinal imaging of 

SARS-CoV-2 infection using luminescence as well as fluorescent reporter viruses. The 

methods and techniques are described in sufficient detail for others to follow and 

reproduce. 

Response: We also appreciate the overall positive and constructive comments made 

by this reviewer regarding the quality of the data, the methodologies and techniques 

described, that will be useful for others to follow and reproduce. 

 

Major comment: A comparison of luminescence and fluorescence-based imaging is 

lacking. Based on the data shown, one can assume that non-invasive longitudinal imaging 

that can be carried out using luminescence-based approach may not be possible using a 

fluorescence-based readout as the authors have shown images of only organs (lungs) 

after necropsy. If true, this needs to be mentioned at least in the discussion so that the 

readers can decide on optimal method to use for their settings. 

Response: We concur with the comment made by the reviewer and thank him/her for 

bringing this important comment. Following his/her recommendation, we have included 

changes in our revised version of the manuscript addressing this reviewer’s comment. 

 

Minor comment: There is a typo in Figure 4A lower panel. It should be rSARS-CoV-

2/Venus and not Nluc. 

Response: Results shown in Figure 4 relate to rSARS-CoV-2/Venus. We have 

carefully review Figure 4A and all the legends refer to rSARS-CoV-2/Venus. 

 

 

 

 

 



Editorial comments 

 

Editorial Comment #1: Please take this opportunity to thoroughly proofread the 

manuscript to ensure that there are no spelling or grammar issues. 

Response: We have carefully revised the manuscript for spelling and grammar 

issues. Any grammar mistakes have been fixed in the revised version of the manuscript.  

 

Editorial Comment #2: Please provide a 10-50-word summary to clearly describe 

the protocol and its applications in complete sentences. 

Response: We have included a short summary in the revised version of the 

manuscript. 

 

Editorial Comment #3: Please revise the following lines to avoid previously 

published work: 30-31, 72-75, 137-138, 165-166, 168-169, 176-177,180-181,226-228. 

Please refer to the iThenticate report attached. 

Response: Similarly worded lines to previous publications have been fixed in the 

revised version of the manuscript.  

 

Editorial Comment #4: For in-text formatting, corresponding reference numbers 

should appear as numbered superscripts after the appropriate statement(s) before 

punctuation. 

Response: We have applied the JoVE endnote style in the revised version of the 

manuscript.  

 

Editorial Comment #5: Please adjust the numbering of the Protocol to follow the 

JoVE Instructions for Authors. For example, 1 should be followed by 1.1 and then 1.1.1 

and 1.1.2 if necessary. 

Response: We have corrected the numbering format in the revised version of the 

manuscript. 

 



Editorial Comment #6: JoVE cannot publish manuscripts containing commercial 

language. This includes trademark symbols (™), registered symbols (®), and company 

names before an instrument or reagent. Please remove all commercial language from 

your manuscript and use generic terms instead. All commercial products should be 

sufficiently referenced in the Table of Materials. For example: The Jackson Laboratory 

(Bar Harbor, ME, USA), Precelleys homogenizer, QUIP Laboratories, Wilmington, DE, 

USA, iPhone 6s (Apple, CA, USA), Sigma, Nano-Glo® Luciferase Assay System 

(Promega), Aura Imaging software, Wexicide, Ami HT, Vectastain ABC kit, Vector 

Laboratory, etc. 

Response: We have removed all commercial language in the revised version of the 

manuscript. 

 

Editorial Comment #7: Please ensure that all text in the protocol section is written 

in the imperative tense as if telling someone how to do the technique (e.g., “Do this,” 

“Ensure that,” etc.). The actions should be described in the imperative tense in complete 

sentences wherever possible. Any text that cannot be written in the imperative tense may 

be added as a “Note.” However, notes should be concise and used sparingly. 

Response: We have corrected the text to be written in imperative tense in the revised 

version of the manuscript. 

 

Editorial Comment #8: Please add more details to your protocol steps. Please 

ensure you answer the “how” question, i.e., how is the step performed? 

Response: We have revised the manuscript and included more detailed information 

in the protocol steps in the revised version of the manuscript. 

 

Editorial Comment #9: Please provide the volume of all solutions used (BSA, neutral 

buffered formalin, etc.) 

Response: We have revised the manuscript and included this information in the 

revised version of the manuscript. 

 



Editorial Comment #10: Line 145: Are the mice disinfected before shaving? If yes, 

please mention how? Also, describe which part of the chest was shave and how? 

Response: We apologize for not providing this information in our initial submission 

of the manuscript. This information has been now included in the revised document.  

 

Editorial Comment #11: Line 146: How were PFUs counted? 

Response: We have provide information on how the PFUs are counted in our revised 

manuscript. 

 

Editorial Comment #12: Line 150: What is the final volume? 

Response: We have included this information in the revised manuscript. 

 

Editorial Comment #13: Line 153: What was the percentage of isoflurane used? 

Please mention how proper anesthetization is confirmed. Please specify the use of vet 

ointment on eyes to prevent dryness while under anesthesia. 

Response: We have included this information in the revised manuscript. 

 

Editorial Comment #14: Line 165,186: For steps that involve software or analyzing 

tools, please make sure to provide all the details such as “click this”, “select that”, “observe 

this”, etc. Please mention all the steps that are necessary to execute the action item. 

Please provide details so a reader may replicate your analysis including buttons clicked, 

inputs, screenshots, etc. Please keep in mind that software steps without a graphical user 

interface (GUI) cannot be filmed. Please provide all parameter and setting details. 

Response: We have revised our manuscript and included the steps suggested in the 

revised version of the manuscript. 

 

Editorial Comment #15: Line 216: How was the ImageJ analysis done? Please 

provide all details. 

Response: We have included details on ImageJ analysis in the revised version of 

the manuscript. 

 



Editorial Comment #16: Line 242: How was the PFU calculated? 

Response: We have provide information on how the PFUs are calculated in our 

revised manuscript. 

 

Editorial Comment #17: Please include a single line space between all the steps. 

Please highlight up to 3 pages of the Protocol (including headings and spacing) that 

identifies the essential steps of the protocol for the video, i.e., the steps that should be 

visualized to tell the most cohesive story of the Protocol. Remember that non-highlighted 

Protocol steps will remain in the manuscript, and therefore will still be available to the 

reader. 

Response: We have included a single line spacing in between steps and highlighted 

sections in the Protocol that identifies the essential steps of the protocol for the video. 

 

Editorial Comment #18: As we are a methods journal, please revise the Discussion 

to explicitly cover the following in detail in 3-6 paragraphs with citations: a) Critical steps 

within the protocol, b) Any modifications and troubleshooting of the technique, c) Any 

limitations of the technique, d) The significance with respect to existing methods, e) Any 

future applications of the technique. 

Response: We have revised the Discussion section to follow editors’ suggestion. 

This has been included in the revised version of the manuscript. 

 

Editorial Comment #19: Figure legends 2/4: Please provide the number of samples 

used in each group in the Figure legends. Please define what the error bars represent 

and what the ** stands for in the figure legend. Please also mention what the color 

intensity bar denotes.  

Response: We have included the sample number and statistics information in the 

revised version of the manuscript. 

 

Editorial Comment #20: Please include a Disclosures section, providing information 

regarding the authors’ competing financial interests or other conflicts of interest. If authors 



have no competing financial interests, then a statement indicating no competing financial 

interests must be included. 

Response: We have included a Disclosure section in the revised manuscript. 

 

Editorial Comment #21: Please ensure that the references appear as the following: 

[Lastname, F.I., LastName, F.I., LastName, F.I. Article Title. Source. Volume (Issue), 

FirstPage – LastPage (YEAR).] For more than 6 authors, list only the first author then et 

al. 

Response: We have applied the JoVE endnote style in the revised manuscript.  

 

Editorial Comment #22: Please remove trademark (™) and registered (®) symbols 

from the Table of Equipment and Materials. 

Response: Trademark and registered symbols have been removed in the revised 

version of the manuscript. 

 

Editorial Comment #23: Figure 2/4: Please revise “PFU/ml” to “PFU/mL” in the panel 

E and F. 

Response: We have changes PFU/ml to PFU/mL in the revised manuscript. 

 

Editorial Comment #24: Please cite the biorxiv article 

(https://www.biorxiv.org/content/10.1101/2021.06.03.446942v1.full.pdf) in the Figure 

legends of the Figures common in both articles (JoVE submission and biorxiv). 

Response: We have included the citation of the biorxiv article in the figure legends 

in the revised version of the manuscript. 

 

We hope that by considering all the comments and suggestions made by the editors 

the manuscript could be now accepted for publication at JoVE. Finally, we want to thank 

again the editors for their very helpful and constructive criticisms that have contributed to 

improve our manuscript. 

Sincerely, 

Luis Martinez-Sobrido, Ph.D. 



Texas Biomedical Research Institute 

 

We hope that by considering all the comments and suggestions made by the 

reviewers the manuscript has been improved, and it could be now accepted for 

publication at JoVE . Finally, we want to thank again the reviewers for their very helpful 

and constructive criticisms that have contributed to improve our manuscript. 

Sincerely, 

Luis Martinez-Sobrido, Ph.D. 

Texas Biomedical Research Institute 
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